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Features of Color Calibration Management Console

Features of Color Calibration Management Console

Color Calibration Management Console is software that allows you to view the color calibration status and execute
color calibration on multiple printers. You can also acquire color measurement data and execute color checks on
printers that have a spectrophotometer unit installed.

@ Display Color Calibration Status

@ Execute Color Calibration

@ Acquire Color Measurement Data

a Execute Color Check

Display Color Calibration Status

The printers connected via the network and USB are displayed in a list in the main window.

If there are multiple printers, printers where color calibration has been executed on the same paper type and that paper
is loaded in the printer are displayed in the same calibration group. Printers that are in the same calibration group can be
corrected to give the same color tones by executing color calibration.

When a printer is selected from the main window, the color calibration status, execution logs, etc. of that printer are
displayed.

For details on how to check the color calibration status, see "Checking the Color Calibration Status (P.24)."

Execute Color Calibration

You can execute color calibration.
Executing color calibration improves color consistency by compensating for slight differences in how color appears due
to individual variations or aging among the printers.

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)."

@ In order to execute color calibration on paper other than genuine Canon paper/feed certified paper, a calibration
target is required for that paper. Calibration targets can be created on a printer with a spectrophotometer unit
installed by using the Media Configuration Tool that is included with printers that support the spectrophotometer

unit.

Acquiring Color Measurement Data from the Color Chart

You can measure the colors of any arbitrary color chart and save the color measurement data on your computer. You
can then create an ICC profile by importing this data into commercially available ICC profile creation software.

For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color
Chart (P.32)."




Features of Color Calibration Management Console

@ This function can be executed when a printer that has a spectrophotometer unit installed is selected.

Execute Color Check

You can execute a color check.

When a color check is executed, a built-in pattern is printed, the color difference from a calibration target registered in
the printer is calculated, and the check results are displayed.

Execute a color check when you want to check the color status of a printer in detail.

For the procedure for executing color check, see "Executing Color Check (P.42)."

@ This function can be executed when a printer that has a spectrophotometer unit installed is selected.




Installation Procedure

Installation Procedure
The installation procedure for the Color Calibration Management Console is as follows.

1 Start the Color Calibration Management Console installer.

2 Click the Next button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard @

Welcome to the InstallShield Wizard for imagePROGRAF Color
Calibration Management Consale

The InstallShield® Wizard will install image PROGRAF Color
Calibration Management Conzole on your computer. To continue,
click Mext.

3 After reading the license agreement, select I accept the terms of the license agreement and click the Next

button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard @

License Agreement
CAMNON SOFTWARE LICENSE AGREEMENT -

IMPORTANT-READ THIS AGREEMENT BEFORE INSTALLING THE SOFTWARE! n

This legal document is a license agreement between you and Canon Inc. ("Canon™)
goveming your use of the software and the online or electric manual (collectively, the
"SOFTWARE"). BY INSTALLING THE SOFTWARE, YOU ARE DEEMED TO HAVE
AGREED TO BE BOUMD BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY CLOSE THIS
INSTALLATION PROGRAM AND DO NOT INSTALL THE SOFTWARE.

In consideration of the right to use the SOFTWARE, you aaree to abide by the terms and
condtions of this Agreement. i

(@ 1 accept the terms of the license agreement

() | do not accept the terms of the license agreement

<Back || Net> | | Cancel




Installation Procedure

4

5

6

Choose a location to install the software and click the Next button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard

Choose Destination Location

Please select the installation folder.

Destination Folder
C:*Program FilegCanon%iPFCCMC

Change...

<Back || Nea> | | Cancel |

Click the Install button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.
Click Install to beqin the installation.

If you want to review or change any of your installation settings, click
Back. Click Cancel to exit the wizard.

<Back || instal | [ Cancel

If you want to create a shortcut to Color Calibration Management Console on the Desktop, click the Yes button.

' imagePROGRAF Color Calibration Management Console - InstallShield Wizard = 52

Create a shortcut on the desktop?




Installation Procedure

7 Select Yes, I want to restart my computer now. or No, I will restart my computer later. and click the Finish

button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed imagePROGRAF
Color Calibration Management Console. Before you can use the
program, you must restart your computer.

(@) Yes, | want to restart my computer now

() Mo, 1 'will restart my computer later.

Click Finish to complete setup.

< Back Cancel

To complete the installation of the Color Calibration Management Console, restart your computer.




Uninstallation Procedure

Uninstallation Procedure

The uninstallation procedure for the Color Calibration Management Console is as follows.

1

2

3

From the start menu, click All Programs>imagePROGRAF Color Calibration Management

Console>Uninstaller (imagePROGRAF Color Calibration Management Console).

Select Remove and click the Next button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard @

Welcome
Repair or remaove the program.

(") Repair

ﬁ Reinstall all program components installed by the previous setup.

Remove all installed components.

Ned> | | Cancel

Click the Finish button.

imagePROGRAF Color Calibration Management Conscle - InstallShield Wizard

Uningtall Complete

InstallShield Wizard has finished perfforming maintenance operations
on imagePROGRAF Color Calibration Management Consale.

(]
i)
o
Al

This completes the uninstallation of the Color Calibration Management Console.




Startup

Startup

The startup procedure for the Color Calibration Management Console is as follows.

Double-click the Color Calibration Management Console icon on the desktop.

%‘14‘
Color Calibration

Management ...

This displays the Color Calibration Management Console main window.

7 imagePROGRAF Color Calibration Management Console - iPFioco: soox.00c 00600 1ooex o= =
File Tools Help
Fririt
b [ Caliration “ L e— (7]
Canon iPFisxs
B Canon P E=
Paper Being Fed: Heavpweight Coated Paper
Mormnal
G Caliration
Advisability of executing color calibration: =
Calibrated hd
Media Type Status Color Calibration Date
ﬁ Heavyweight Coated Paper Narmal 8/3/2011 11415 P _
Status Maritor.. £l mn §

%
@ If there is no Color Calibration Management Console icon on the desktop, click start and navigate to All

Programs>imagePROGRAF Color Calibration Management Console>imagePROGRAF Color Calibration
Management Console.




Main Window

Main Window

The Color Calibration Management Console main window consists of a title bar, menu bar, Printer list, Calibration

sheet, and Color Measurement sheet.

You can switch between the Calibration sheet and Color Measurement sheet by clicking the A Calibration button or

B Color Measurement button. You can also switch between the sheets from the File menu in the menu bar.

Yo imagePROGRAF Color Calibration Management Consele - IPFocot :0063006.100.500¢ 1000t

Lol e ]
File Tools Help
—A B
Printer
[ Calbration H Color Measurement (7]
Canon iPFiaxs
B Cancn PFioss E=
Paper Being Fed Heawyweight Costed Paper
Mormal
‘ﬁ‘é Calibatior
Advisability of executing color calibration; =
Calibrated -
Media Type Statug Colar Calibration Date =
ﬁ Heavpweight Coated Paper Normal 8/3/201 11415 P
Status Monitor Ll [ 3

Displays the model name, port name, and installation location of the printer selected in the Printer list.

{ i imagePROGRAF Color Calibration Management Console - iP Fooot soocacoc o000 1oac

Menu bar

Allows you to select the menu items for the necessary operations.

File Tools Help

For details on each of the menu items, refer to the following topics.

o File Menu (P.13)

= e |

@ Tools Menu (When the Calibration Sheet is Displayed) (P.14)

s Tools Menu (When the Color Measurement Sheet is Displayed) (P.15)

s Help Menu (P.17)




Main Window

Printer List
Displays a list of printers that can be controlled. For details, see "Printer List (P.18)."

Printer [
-

Canon iPFrxxe
Bl Canon iPFrame

[ Printer Infoimatian... ]

[ Status Monitar... ]

[ Accounting... ]

10



Main Window

Calibration Sheet

This sheet allows you to execute color calibration. For details, see "Calibration Sheet (P.20)."

[ Calibration “ Calor Measurement 9

Erecute

Paper Being Fed: Heavyweight Coated Paper

Moarmnal.

‘ﬁr& Calibration

Advizability of executing color calibration: =

[Calirated -]
Media Type Status Color Calibration Drate
H Heavyweight Coated Paper Marmal 8/3/2001 11415 PH
] m | 3
Paper Status. ..

Color Measurement Sheet
This sheet allows you to acquire color chart measurement data and execute color check. For details, see "Color

Measurement Sheet (P.22)."

11



Main Window

L~

@ Enabled when a printer that has a spectrophotometer unit installed is selected.

[ LCalibration “ Colar Measurement ] o
@ Color Measure ‘ ‘ Q Color Check ‘
Execution Logs
Media Type Paper ‘wWidth Statuz Start Time Mame
] I | k
Save Data... Laog Details...

12



File Menu

File Menu

This section describes each of the menu items in the File menu.

Tools Help

Calibration

& Color Measurement

Update Printer List

Printer Information...

Status Manitor...

Accounting...
Preferences...

Exit

Calibration / Color Measurement

Selects the main window sheet.

Update Printer List

Refreshes the Printer list on the left side of the main window with the latest information.

Printer Information
Displays the Printer Information dialog box for the printer selected in the Printer list.

This allows you to check detailed information about the printer.

Status Monitor
You can start the imagePROGRAF Status Monitor for the printer selected in the Printer list, allowing you to confirm

information such as the status of print jobs.

Accounting
You can start the imagePROGRAF Status Monitor Accounting Manager main window for the printer selected in the

Printer list, allowing you to confirm information such as the cost of printing.

Preferences
Displays the Preferences dialog box.
This allows you to select the units displayed in the Color Calibration Management Console, configure the sound that is
displayed when executing a color calibration, acquiring color measurement data, or executing a color check finishes,
and configure other settings.

Exit

Exits Color Calibration Management Console.

13



Tools Menu (When the Calibration Sheet is Displayed)

Tools Menu (When the Calibration Sheet is Displayed)

This section describes each of the menu items in the Tools menu when the Calibration sheet is displayed in the main

window.
el
Calibration
Close Dialog When Finished
& Calibrated
All
Custorm Paper
Baper Status... I
Update
Calibration

Displays the Execute Color Calibration dialog box.
Executes color calibration on the selected printer.

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)."

Close Dialog When Finished
Selects whether or not to close the progress dialog box automatically when the color calibration finishes.

When the check box is selected, the progress dialog box closes automatically.

Calibrated/All/Custom Paper
Selects the paper types displayed in the main window (Calibration sheet).

Paper Status
Displays the Paper Status dialog box.

This allows you to check the color calibration and color check execution logs for the selected paper.

Update

Refreshes the paper list in the main window with the latest information.

14



Tools Menu (When the Color Measurement Sheet is Displayed)

Tools Menu (When the Color Measurement Sheet is Displayed)

This section describes each of the menu items in the Tools menu when the Color Measurement sheet is displayed in

the main window.

@ Enabled when a printer that has a spectrophotometer unit installed is selected.

Acquire Color Measurernent Data

Color Check

v Display Procedure Window
Close Dialeg When Finished

Favorites...

Leg Details...
Save Data...

Qutput Execution Log C5V k

Acquire Color Measurement Data
Displays the procedure description window or Select Execution Log window.
This allows you to measure the colors of a color chart in the selected printer and acquire the color measurement data.
For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color
Chart (P.32)."

Color Check
Displays the Execute Color Check dialog box.
Execute color check on the selected printer.

For the procedure for executing color check, see "Executing Color Check (P.42)."

Display Procedure Window
Selects whether or not to display the procedure description window when executing Acquire Color Measurement
Data.

When the check box is selected, the procedure description window is displayed.

Close Dialog When Finished
Selects whether or not to close the progress dialog box automatically when Color Check or Acquire Color
Measurement Data finishes.

When the check box is selected, the progress dialog box closes automatically.

Favorites

Displays the Favorites Management dialog box.

15



Tools Menu (When the Color Measurement Sheet is Displayed)

This allows you to check the execution logs registered in the favorites.

Log Details
Displays the Execution Log Details dialog box.

This allows you to check the details of the execution log selected in Execution Logs in the main window.

Save Data
Displays the Output Color Measurement Data dialog box.
This saves the color measurement data of the execution log selected in Execution Logs in the main window on the

computer.

@ This menu cannot be selected if multiple execution logs are selected.

Output Execution Log CSV
When Selected Logs is selected, this saves the execution log selected in Execution Logs in the main window on the
computer in a CSV format file.
When All Logs is selected, this saves all of the execution logs displayed in Execution Logs in the main window on the

computer in a CSV format file.

16



Help Menu

Help Menu
This section describes each of the menu items in the Help menu.

Help
About...

Help
Displays the Color Calibration Management Console help.

About

Displays the About dialog box, which allows you to check the version of Color Calibration Management Console.

17



Printer List

Printer List

The printers displayed in the Printer list are printers connected via the network or USB that satisfy the following
conditions. However, printers that are connected via a server are not displayed.

@ Printers that are compatible with the Color Calibration Management Console

@ Printers where the printer driver is installed

Frinter [
-

Calibration group 1
Canon iPF oo
f Canon iPF

I Pririter [nfarmation I

I Status Monitor I

I Accounting I

Printer
If color calibration is executed on the paper being fed, printers that are being fed the same paper are displayed under the
Calibration group.
is displayed on printers that have a message related to color calibration.
B i displayed on printers where the spectrophotometer unit is installed.
Double-click the printer name to display the Printer Information dialog box, allowing you to check the detailed

printer information.

@ Printers that are added, deleted, or have their name changed while Color Calibration Management Console is
running are not updated in the Printer list. If you want to update the Printer list, exit and then restart Color

Calibration Management Console.

‘® button

Click this button to refresh the Printer list with the latest information.

18



Printer List

Printer Information button
Click this button to display the Printer Information dialog box for the selected printer, allowing you to check the

detailed printer information.

Status Monitor button
Click this button to start the imagePROGRAF Status Monitor for the selected printer, allowing you to confirm

information such as the status of print jobs.

Accounting button
Click this button to start the imagePROGRAF Status Monitor Accounting Manager main window for the selected

printer, allowing you to confirm information such as the cost of printing.

19



Calibration Sheet

Calibration Sheet

This sheet allows you to execute color calibration and check the color calibration status of the printer selected in the

Printer list.

l Calibratiot “ Calar Measurement 9
Execute
Paper Being Fed: Heavyweight Coated Paper
Marmal.
ﬂ-ﬁ»& Calibration

Advisability of sxecuting color calibration: N

[Calbrated -

Media Tupe Statuz Color Calibration Date =
H Heavyueight Coated Paper Mormal 832011 11415 P
« L 1 ] p
FPaper Status...

Paper Being Fed
Displays the media type being fed in the printer.

Calibration button
Click this button to display the Execute Color Calibration dialog box.
Executes color calibration on the selected printer.

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)."

Advisability of executing color calibration

Displays the status until it is recommended that you execute color calibration. The progress bar grows until the time

when calibration is recommended.

Paper Status button
Click this button to display the Paper Status dialog box.

This allows you to check the color calibration and color check execution logs for the selected paper.

20



Calibration Sheet

Color calibration status for each paper

[Calirated -

Media Type Status Color Calibration Date
ﬁ Heavyweight Coated Paper Marmal 8/3/2001 11415 PH

Click the & button to refresh the list with the latest information. ™ is displayed on the paper currently being fed in

the printer.

The paper types displayed in the list are as follows.

When Calibrated is selected

Paper types that are registered in a printer where color calibration has been executed are displayed.

When All is selected

Paper types registered in a printer are displayed.

When Custom Paper is selected

Paper types other than genuine Canon paper and feed certified paper that are registered in a printer are displayed.

21



Color Measurement Sheet

Color Measurement Sheet

This sheet allows you to use the spectrophotometer unit to measure colors.

[ LCalibration |l Color Measurement J o

E Calor Measure ‘ ‘ w Calor Check ‘

Execution Logs

Media Tupe Paper Width Status Stark Time Mame

4 n k

Save Data.. Log Details...

Color Measure button
Click this button to display the procedure description window or Select Execution Log window.
This allows you to measure the colors of a color chart in the selected printer and acquire the color measurement data.
For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color
Chart (P.32)."

Color Check button
Click this button to display the Execute Color Check dialog box.
Execute color check on the selected printer.

For the procedure for executing color check, see "Executing Color Check (P.42)."

Execution Logs

Displays the execution logs of acquiring color measurement data.
=i displayed on the paper being fed.

The name registered in the favorites is displayed in Name.

Save Data button
Click this button to display the Output Color Measurement Data dialog box.

This saves the color measurement data from the selected execution log on the computer.

22



Color Measurement Sheet

Favorites button
Click this button to display the Favorites Management dialog box.

This allows you to check the execution logs registered in the favorites.

Log Details button
Click this button to display the Execution Log Details dialog box.

This allows you to check the details of the selected execution log.

23



Checking the Color Calibration Status

Checking the Color Calibration Status

You can check the color calibration status and execution logs on the Calibration sheet in the main window.

1 Open the Calibration sheet.

! imagePROGRAF Color Calibration Managerent Console - iPFooc 1001006100000 10000 =N Non
File Tools Help

Print

et [ Calbratian “ Color Measurement (7]

Canon iPFiaxs
Bl Canon PR Evacute

Paper Being Fed Heawpmeioht Coated Paper

Marmal .
‘ﬁﬁ Calibration

Advisabilty of executing color calibration: |

Calibrated -
Media Type Status Color Calibration Date *
= Heawweight Coated Paper Moimal 8/3/2011 11415 P

Piinter Information.
Status Manitar 4 i | v

2 Select the printer you want to check the color calibration status of from the Printer list.

7 imagePROGRAF Color Calibration Management Console - iPFioao o006 006000 1000 =N e
File Tools Help

Fiint

b [ Caliration “ L e— (7]

Canon iFFasss

Enxecute

Paper Being Fed: Heavpweight Coated Paper

Momal N
G Calibration

Advisability of executing color calibration b |

Calibrated hd
Media Type Status Color Calibration Date
ﬁ Heavyweight Coated Paper Narmal 8/3/2011 1:14:15Ph

Frinter Information.
Status Manitor.. < m | »

6/

@ If there are multiple printers, printers that have the same paper type loaded and where color calibration has been

24



Checking the Color Calibration Status

executed on that paper are displayed in the same calibration group.

3 Check the color calibration status of the paper being fed in the upper part of the Calibration sheet.

Paper Being Fed Heavyweight Coated Paper

Mormal.

Advissbilly of skecuting oclor callration: =

4 Select Calibrated and click the 1" button.

! imagePROGRAF Color Calibration Managerent Console - iPFooc 1001006100000 10000 =N Non
File Tools Help

Prirter
[ Calbration “ Color Measurement (7]

Canon PP

Execute

Paper Being Fed Heawpmeioht Coated Paper

Normal N
(ﬂﬁ Calbratior

Advisability of executing color calibration; !

Calirated )|

Media Type Status Color Calibration Date =
ﬁ Heavpweight Coated Paper Normal 8/3/201 11415 P
Status Monitor < | m | »

25



Checking the Color Calibration Status

5  Check the color calibration logs in the lower part of the Calibration sheet.

Calbrated -
Media Typs Status Color Calibration Date =
= Heavpweight Costed Paper Normal B/3/2011 11415 PH

26



Executing Color Calibration

Executing Color Calibration

The procedure for executing color calibration is as follows.

Getting the Printer Ready

1 You can confirm whether the paper to be loaded can be used in color calibration.

2 Load the paper.

@ If Adj. Quality has not been executed even once on the paper you are using when you execute Auto Adjust (High

Precision), execute Adj. Quality in the control panel menu.

3 Ifa spectrophotometer unit is mounted, select the White/Black Backing Plate color.

We recommend white.

@ For the color of the White/Black Backing Plate, continue using the selected color without changing each time you

execute color calibration.

Executing Color Calibration

1 Open the Calibration sheet.

' imagePROGRAF Color Calibration Management Consale - iPFooot soaa0x.1001.00¢ 1000

(=8 Eol =
File Tools Help
Printer
[ Calibnation H Color Messurement (7]
Caran PP
EH Canon PFiss EE
Paper Being Fed Heavpweight Coaled Faper
Mormal.
“ﬂﬁ Calibration
Advisability of executing color callbration: L
Calbrated -
Media Type Status Color Calbration Date
= Heawpwsioht Costed Paper Normal

B/3/2011 11415 P

Status Maritor..

T

b

Paper Status

27



Executing Color Calibration

2 Select the printer you want to execute color calibration on from the Printer list.

' imagePROGRAF Color Calibration Management Console - iPFocot soox0c. 00200 1000 =
File Tools Help
Fiint
e [ Calbration ” Color Measurement (7]

anon iPF s

Execute

Paper Being Fed. Heavypweight Coated Paper

Moimal.
Calibration

Advisability of executing calor calibration .
Calibrated -

Media Typs Status Color Calitration Date =
= Hesvywsight Coated Paper Normal 8/3/2011 11415 P _

Piinter Information.
Status Monitor.. < i ] v

3 Click the Calibration button.

&' imagePROGRAF Color Calibration Management Console - iPFooot 10600 100300¢ 1000k
File Tools Help

Prirter
. [ Calibration ” Color Measurement (7]

Canon iPFasss

Execute

Paper Being Fed Heawpweight Coated Paper

Moimal.
Calibration

Advisability of executing color calibration; !
Calibrated

Media Type Status Color Calibration Date =
ﬁ Heavpweight Coated Paper MNormal 8/3/2M1 11415 P

Printer Information.
Status Monitor Ll [ ] 3
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Executing Color Calibration

4

The Execute Color Calibration dialog box is displayed.

-

-]

-]

5

Execute Color Calibration @

Set the color calibration type and pattern zize. The pattern size can be
get for automatic adjustment [high precizion).

Color Calibration T wpe:

| At Adjust [High Precision) v

Fattern Size:

| Standard - |

Confirmation

Media type: Heawvpweight Coated Paper
Apply the color calibration correction walues o this media type only.

Help | ] l | Cancel

Color Calibration Type

-

Select Auto Adjust (High Precision) to execute color calibration using the spectrophotometer unit, or select

Auto Adjust to execute color calibration using the sensors in the printer.

Enabled when a printer that has a spectrophotometer unit installed is selected.

Pattern Size

You can select this setting when Auto Adjust (High Precision) is selected in Color Calibration Type.

We recommend Larger when you want to prioritize the color measurement precision.

Enabled when a printer that has a spectrophotometer unit installed is selected.

Click the OK button.

29



Executing Color Calibration

6 When the Execute Color Calibration dialog box is displayed, check the details.

-

Execute Color Calibration @

About to execute uzing the following zettingz. Proceed?

Printer M ame: Canar IPFessy
Product Mame: IPF s
Part M arme: W, R S, B

Installation Location:

Media Type: Heawyweight Coated Paper
Type: Auto ddiust [High Precision]
Pattem Size: Standard
| Execute | | Cancel |

7 Click the Execute button.

Color calibration will be executed.

o a

Calibration IPP000C 300000000000 @

Caolor calibration is executing.

0%

Cloze thig dialog automatically when finighed | Cancel

@ You can exit the color calibration in the middle by clicking the Cancel button. However, it may take some time to

end.

30



Executing Color Calibration

8  Click the OK button.

o a

Calibration IPFX000C 2000000000200 E

Calar calibration has finizhed.

100 %

[ ] Clage this dialog automatically when finizhed

31



Acquiring Color Measurement Data For Any Color Chart

Acquiring Color Measurement Data For Any Color Chart

The procedure for printing a color chart, measuring the colors, and saving the color measurement data on a computer is
as follows.

The color measurement data saved on the computer can be used such as for creating ICC profiles. ICC profiles are
created using commercially available software.

Created ICC profiles can be used by the printer driver.

@ This step can be executed when a printer that has a spectrophotometer unit installed is selected.

Getting the Printer Ready

1 Confirm whether the paper to be loaded can be used for acquiring color measurement data.

2 Load the paper.

@ If Adj. Quality has not been executed even once on the paper you are using, execute Adj. Quality in the control

panel menu.

3 Select the White/Black Backing Plate color.

Acquiring Color Measurement Data

1 Open the Color Measurement sheet.

Yo imagePROGRAF Color Calibration Management Consele - IPFocot :0063006.100.500¢ 1000t E@
Eile Tools Help

IFET [ Calibation “ Colar Measurement J o

Canon PP
Bl Canon P

B ColbrMesu Hw Color Check ]

Execution Logs

Media Type Paper width Status Start Time MName

Piinter Information.
Statuis Monitor 4 1 )
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Acquiring Color Measurement Data For Any Color Chart

2 Select the printer you want to measure the color chart on from the Printer list.

' imagePROGRAF Color Calibration Management Console - iPFocot soox0c. 00200 1000 o) o=
File Tools Help
IF3t= { Calibration H Colog Measurement I o
Caron iPFrms
=] Canon iFF B Colrheane HQ Color Check. ]
Execution Logs
Media Type Paper Width Status Start Time Name:

Fiinter Infoimation.
Status Monitor. 4 I I b

3 Click the Color Measure button.

! imagePROGRAF Color Calibration Management Consale - iPFooot 1060061001.00¢ 1000

File Tools Help

Frinter [ Calibration H Color Measurement I

Canon PP

on iPF)

B Colrbeae HQ Color Check ]

Execution Logs

Medis Type Paper width Status Statt Time Nams

Printer Information,
Status Monitor 4 1 ] b

33



Acquiring Color Measurement Data For Any Color Chart

4 Check the color chart measurement procedure in the procedure description window and then click Start.

7o Acquire Color Measurement Data iPFooe oot 00000000 0000 EI@

Color Measurement Data Acquisition Procedure (7]

Step 1:  Select Execution Log

Select the settings walues for color measurement data acquisition from the favorites sheet or log sheet.

Step 2:  Print Setlings
Canfigure the color chart, media type, print quality, and other settings.
Step 3:  Color Measurement Settings
Set the diving and color measurement methods.
Step 4:  View Seltings
Canfirm the settings before executing
Step 5:  Execute

Execute acquire color measurement data using the configured settings

Da not display this windaw again

5  Select New in Favorites and then click Next.

Y& Acquire Color Measurement Data iPFoo 0061006300000 10000 EI@
1/5 Select Execution Log Name: New 0
Favortes - Frint Settings

Chart:

Mame Foll Paper \Width:

MNew Media Type
Print Pricrity:
Print Quality:
Automatic Cutting:
Label Print:

Color

Diying Settings:
llumination:

Obszerver Angle:

“ T b

Comment:
Start & new operation.

Details...

Back | | Hext ‘ | Cancel

@ To perform color chart measurement using the setting values when executed previously, select the execution log in

the Favorites sheet or History sheet.
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Acquiring Color Measurement Data For Any Color Chart

Select the color chart, configure the color chart print settings, and then click Next.

2f5 Print Settings

Chart:

7o Acquire Color Measurement Data iPFooe oot 00000000 0000

Name: New (7]

[E=5 Eoh )

[TC283RGB.M

'][ Browse... ]

Fioll Paper Width:

[24in. Roll (509.Emm)

'] [ Acguire Info. ]

[ Canserve Paper

Media Type:

[Eanon Heawyweight Coated Paper

Print Priority:

[Proof

PFrint Quality:

[High (E00dp)

Extend print pass

Paper Source:

[Holl Paper

Autamatic Cutting

[Yes

Frint Labels

‘wiidth: 24.00 inch
Length: 9.19inch

| Back |[ Cancel ]

Setting Item Details
Chart Selects the color chart to print. If the color chart you want to print is not
displayed in the list, click the Browse button and then select the color chart.
You can only select color charts that are CGATS format RGB.
Roll Paper Width Click the Acquire Info. button to display the paper width of the roll loaded

in the printer.

Conserve Paper

Selecting this check box allows you to conserve paper by reducing the gap

between the pieces of a color chart when the chart is printed split into pieces.

Media Type

Select the type of paper.

Print Priority

Choose the graphic elements that you want to emphasize for printing.

Print Quality

Choose the print quality.

Extend print pass

Uneven printing may occur when printing with the Highest setting in Print
Quality. Selecting this check box may improve the uneven printing.

However, the printing speed will be reduced.

Paper Source

Selects the paper source.

Automatic Cutting

Selects how to cut the paper when Acquire Color Measurement Data

finishes.

Print Labels

Select this check box to print the color chart printing information.

35




Acquiring Color Measurement Data For Any Color Chart

7 Configure the color measurement settings and drying settings, and then click Next.

7o Acquire Color Measurement Data iPFooe oot 00000000 0000 EI@
3f5 Color Measurement Settings Name: New (7]

Color Measurement Preferences

() Standard

@ Beparate Setling

Total Drying Time:  00:02:30
[ Beduce Diving Time

Color Measurement Settings

lurnination:

(D50 -]

Observer Angle:

E =)
L Cut:

(e =)

Color Measurement Y alue:

@b [Cxvz

‘wiidth: 24.00 inch
Length: 9.63 inch

Back ][ Mext ][ Cancel ]

Setting Item Details

Color Measurement Configures the pattern size to print the color charts and the drying settings
Preferences for the printed color charts.

Choose Standard to print at the standard pattern size and dry using the
standard setting values.

Click the Settings button to display the Color Measurement Preferences
dialog box, which allows you to configure the pattern size and drying

method in detail.(*1)

Reduce Drying Time Selecting this check box reduces the drying time.

Once the time configured in the Color Measurement Env. sheet in the
Preferences dialog box has elapsed, color measurement proceeds without
performing any further drying with the ventilation fan.

Specify a time that offers sufficient drying by air drying in the Preferences
dialog box. If you perform color measurement while the ink is not dry, the
measurements may not be correct.

The Preferences dialog box is displayed when you click Preferences in the
File menu.

If the number of patterns is small, drying will finish in a shorter amount of
time than the time configured in the Preferences dialog box. If this happens,
the drying time will not be reduced even if the Reduce Drying Time check

box is selected.

INlumination Select the illumination from D50, D65, and A.
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Acquiring Color Measurement Data For Any Color Chart

Setting Item Details
Observer Angle Selects the observer angle.
UV Cut Selects whether or not UV cut is used.
Color Measurement Value Saves the color measurement data for the color measurement values where

the check box is selected.

The Lab check box cannot be cleared.

*1:If you want to enlarge the color chart pattern or configure the color chart drying settings in detail, click the Settings button to

display the Color Measurement Preferences dialog box.

o =

Color Measurement Preferences @

Pattern Size:

Diving b ethod:
@ "entilation Fan
Select diying time eveny zid pattern lines.
Timne 795 sec (103600 seconds)
Beduce Diving Time

Airflows | Standard - |
Air Drying
Dy Separated Chart
1] 1]

Total Dving Time: 00:02:30

Position of Yentilation Farn:
@ Standard
High

| Defaults | | a, || Cancel || Help

Setting Item Details

Pattern Size Selects the pattern size of the color chart.
We recommend Larger when you want to prioritize the color measurement

precision.

Drying Method Choose Ventilation Fan to dry using the ventilation fan or Air Drying to
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Acquiring Color Measurement Data For Any Color Chart

Setting Item

Details

dry without using the ventilation fan.

Ventilation Fan

Configures the drying time and airflow for the ventilation fan.

Time

Configures the drying time for the ventilation fan for each pattern.

The number of lines that are dried at one time by the ventilation fan varies
depending on the size selected in Pattern Size.

As the time increases, the adhesion of the ink improves and the color tones

become more stable.

Reduce Drying Time

Selecting this check box reduces the drying time.

Once the time configured in the Color Measurement Env. sheet in the
Preferences dialog box has elapsed, color measurement proceeds without
performing any further drying with the ventilation fan.

Specify a time that offers sufficient drying by air drying in the Preferences
dialog box. If you perform color measurement while the ink is not dry, the
measurements may not be correct.

The Preferences dialog box is displayed when you click Preferences in the
File menu.

If the number of patterns is small, drying will finish in a shorter amount of
time than the time configured in the Preferences dialog box. If this happens,
the drying time will not be reduced even if the Reduce Drying Time check

box is selected.

Airflow

Selects the airflow of the ventilation fan.

Air Drying

Sets the period between the color chart being printed and the color
measurement starting.

If the Dry Separated Chart check box is selected, printing and air drying
are repeated for each separated color chart. This makes it harder for the color
charts to become scratched or soiled, but also increases the time taken by the
operation.

If the Dry Separated Chart check box is clear, printing and air drying the
color chart are performed once. This reduces the time taken by the
operation, but may scratch or soil the end of the color chart and paper.

However, this does not affect the color measurement results.

Position of Ventilation Fan

If you are using paper that has a tendency to curl or paper that does not dry
easily, select High so that the paper does not come into contact with the
paper presser.

Note that when High is selected, we recommend that you set the Time
longer and the Airflow stronger compared with when Standard is selected

because of the larger distance between the ventilation fan and paper.
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Acquiring Color Measurement Data For Any Color Chart

8  The View Settings window is displayed

. Check the details of the settings and click the OK button.

' Acquire Color Measurement Data iPFioco: sooticoccotionl 1oeoc

4f5 View Settings Name: New

(=)@ ==
o

Fiint Setting
Chart: o283 rghutet
Fioll Paper \width: 24-in. Foll [609.6mm)]
Media Type: Canon Heavyweight Coated Paper
Print Priority: Proof
Prrint Gluiality: High (500dpi)
Automatic Cutting: ez
Label Print: e
Color
Diying Settings: Separate Settings

D50
2

llumination
Observer Angle:

Add to Favoiites...

‘width: 24.00 inch

Length: 9.19inch

Back ][ Cancel |

%.

@ Click the Add to Favorites button to display the Add to Favorites dialog box, which allows you to add the setting

details to favorites.

9  The Output Color Measurement Data

dialog box is displayed.

Select the file to save the color measurement data into and click the OK button.

Qutput Color Measurement Data

File Marme:;

| Browse. .. |
File Format;

| CGATS v

(k. [ Cancel

10 The Acquire Color Measurement Data dialog box is displayed.
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Acquiring Color Measurement Data For Any Color Chart

Click the Execute button.

Acquire Color Measurement Data @

About to execute using the follawing settings. Proceed?

Frinter M ame; Canor iPF s
Product Name: IPF sy
Part Mame: M E

Inztallation Location:

Execute ] |[ Cancel

The color chart is printed and color measurement begins.

L =

Canon iPPODO 300(00C00.00¢ | & ||

Acqguirning color meazurement data,

Tatal Progress:

b eazunng calar.

Remaining Time; 00:00:00

[] Cloge this dialog autamatically when finizhed

@ You can exit the acquire color measurement data operation in the middle by clicking the Cancel button. However,

it may take some time to end.
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Acquiring Color Measurement Data For Any Color Chart

11

Click the OK button.

Canon iPRO0O 2000000 X000 EE

Acguinng color meazurement data has finished.

Total Progress:

The finalization procezzsing has finshed.

[ Close this dialog automatically when finizhed

Once the color measurement has finished, the color measurement data is saved on the computer.
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Executing Color Check

Executing Color Check

When a color check is executed, a built-in pattern is printed, the color difference from a calibration target registered in
the printer is calculated, and the check results are displayed.

@ This step can be executed when a printer that has a spectrophotometer unit installed is selected.

@ When printing the color check adjustment pattern, the calibration adjustment values are applied even if Use Adj.
Value is set to Disabled in the Control Panel menu.

Setting the Color Check Threshold Value
1

Double-click the printer you want to execute the color check on in the Printer list.

i imagePROGRAF Coler Calibration Management Consele - iP Fooo sooxacos o000 oo
File Tools Help

= =B
Frirter

[ Caliration “ L e— (7]
Canon Phoms

B Canon P Execute

Paper Being Fed:

Heavpweight Coated Paper
Mormnal

l% Calibration
ddvisabilty of erecuing coor ealbration: [
Calibrated -
Media Typs Status

Color Calibration Date *
B Heawpwsioht Costed Paper

87372011 11415 Ph

Marrnal

Status Maritor..

[ »

Paper Status.
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Executing Color Check

2 Click the Settings button for Color Check in the Printer Information dialog box.

Printer Information @
Prirter
Frinker Mame: Canon iPF s
Product Marme: IPF s
Fart M ame: W, W B

Inztallation Location:

Firmware Wergior; 1.0E
Serial Mumber: A 23456
Calibration Execution Guide: H atify
Spectrophotometer Lnit: ez

Spectrophatameter Sensar

Serial Hurber:
Serial Number of ‘white Calibration Tile:
Firrnware YWersion:

Murnination Tinne:

Backing Plate:

Colar Check.

AFE Threshold Y alue: 1.5

Meszzage

Statuz Monitar. . 0k Help
| |

3 Enter the color check threshold value in AE and click the OK button.
Color Check Settings @

-

Sets the AE calor check threshold value. It is
recommended that pou execute color calibration if this
value iz exceeded when color check iz executed.

AE: = [0.4-5.0)

| k. | Cancel

Getting the Printer Ready

1  Confirm whether the paper to be loaded can be used for color checks.

Paper for color check is paper that can be used with the Auto Adjust (High Precision) setting on the

spectrophotometer unit.
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Executing Color Check

2 Load the paper.

7
@ If Adj. Quality has not been executed even once on the paper you are using, execute Adj. Quality in the control

panel menu.

3 Select the White/Black Backing Plate color.

2
@ For the color of the White/Black Backing Plate, select the color from when color calibration was executed using

the spectrophotometer unit.

(See "Executing Color Calibration (P.27).")

Executing Color Check

1 Open the Color Measurement sheet.

' imagePROGRAF Color Calibration Management Console - iPFocot soox0c. 00200 1000 o) o=
File Tools Help
IF3t= { Calibration [ ol bessuemen o
Canon PP
& CanonPRec: E‘ Color Measure | \u Color Check ]
Execution Logs
Media Type Faper Width Status Start Time Name
Statusg Monitor... 4 L Y
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Executing Color Check

Select the printer you want to execute color check on from the Printer list.

' imagePROGRAF Color Calibration Management Console - iPFocot soox0c. 00200 1000 o) o=
File Tools Help
IF3t= { Calibration H Colog Measurement I o
Caron iPFrms
Caoon B B Colrheane HQ Calar Check ]
Execution Logs
Media Type Faper width Status Start Time: Nama
Status Monitor. 4 I | b
Save Data.. Log Detas...

3 Click the Color Check button.

File Tools Help

! imagePROGRAF Color Calibration Management Consale - iPFooot 1060061001.00¢ 1000

AL [ Calivation H Color Measurement I o
Canon PRaess
B ColrMeze HQ Color Check. ]
Execulion Logs
Media Type: Paper width Status Start Tirme Name
Printer Information.
Status Monitor 4 il ] b
SaveData.. Log Detas...

4 The Execute Color Check dialog box is displayed.

Select Pattern Size.

45



Executing Color Check

To increase the precision of the color check, we recommend that you configure the same settings as when Auto

Adjust (High Precision) was executed in color calibration. (See "Executing Color Calibration (P.27).")

-

Execute Color Check @

Set the pattem size.

Battern Size:

Standard -

Confirmation Meszsage:

tedia wpe: Heavyweight Coated Paper
Perform color check wsing this media bepe.

Help | ok | | Cancel

5 Click the OK button.
6 When the Execute Color Check dialog box is displayed, check the details.

—

Execute Color Check @

About to execute uzing the following settings. Proceed?

Printer M ame: Canar IPFsssy
Product Hame: IPF e
Part Mame: I M M M

Installation Location:

Media Type: Heavwweight Coated Paper
Pattern Size: Standard

Execute || Cancel

7 Click the Execute button.
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Executing Color Check

The color check is executed.

o al

Color Check IPP0COC 30003000 XXX 000 @

Color check iz esecuting.

0%

|| Clase thiz dialog autarmatically when finished

Q

@ You can exit the color check in the middle by clicking the Cancel button. However, it may take some time to end.

8  Check the results.

o a

Color Check IPFx0000 200000000000 @

The colar check has finizhed.

AF: 150 0K
100 %
[] Cloze this dialog automatically when finizhed | Uk |

Q

@ We recommend that you execute color calibration if the results exceed the threshold values.

(See "Executing Color Calibration (P.27).")
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Registering Execution Logs in Favorites

Registering Execution Logs in Favorites

You can register frequently used execution logs in favorites for Acquire Color Measurement Data. Registering an

operation in favorites allows you to attach a separate name for easily recalling the operation.

G/

@ This step can be executed when a printer that has a spectrophotometer unit installed is selected.

@ You can register up to 30 execution logs in the favorites.

1

Select the execution log to register in favorites in Execution Logs in the main window (Color Measurement

sheet).
7' imagePROGRAF Color Calibration Management Console - iPFooot 1o6.00¢.00.00¢ 1000 == EERE<=
File Tools Help
Printer [ Calbraion H Color Msasursment ] o
Canon PR
i [EEronEE | ColorMeasre H(,, Color Check ]
Execulion Logs
Mecia Tune faty Tine Mane
C Complsted 03:32_00:01:17
2= CaronHeavwe.. 24-n Rol (803 Completed 2012/04/1411:42 000110
Stalus Monitor.. ‘ L I
sevebaa. ) [ faveites, ) [ LopDamis. ]

2 Click the Log Details button.
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Registering Execution Logs in Favorites

Click the Add to Favorites button in the Execution Log Details dialog box.

Execution Log Details Acquire Color Measurement Data
Hame: Print Settings
Chart; tce. 83 rgh.tut
Fiall Paper Wwidth: 24-in. Roll [B09.6ram)
Comment: Media Type: Canoh Heavyweight Coated Paper
Print Priority: Proaf
Print Cluality: High [G00dpRi]
Autarnatic Cutting: Yes
Label Frint: Yes
Color Measurermert Settings
Dimying Settings: Standard
lllurnination: DE0
Observer Angle: 2

Add o Favarites... ]

[ Al Infarmation... ]

4 Enter the name in Name. Enter a comment in Comment if needed.

Add to Favaorites

Marne:

Coamment:

Cancel

5  Click the OK button.
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Deleting Execution Logs From Favorites

Deleting Execution Logs From Favorites

You can delete Acquire Color Measurement Data execution logs from the favorites.

af

@ This step can be executed when a printer that has a spectrophotometer unit installed is selected.

1

Click the Favorites button in the main window (Color Measurement sheet).

7 imagePROGRAF Color Calibration Management Console - iPFioco: soox.00c 00600 1ooex o= =
File Tools Help
= { Calibration H Color Measurement I 9
Canan iPFiss
] CoreniFAzzz: [ ColorMeasue HQ Color Check. ]
Execution Logs
Media Type Start Time Name
Coi 0:01:17
ﬁ Canon Heavpwe, Complete: 2012/04/1411:42 00.01:10
Piinter Information.
Status Monitor g i -
Smebas. ||| Fovees. )| Loobmmi |
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Deleting Execution Logs From Favorites

2

Select execution log that you want to delete in Favorites and click the Delete from Favorites button.

Favorites Management iPFxooo

Favorites:

4| 1

Comment:

Delete from Favorites

Prirt Settingz
Chart: tc2 83 rgb.txt
Foll Paper 'width: 24-in. Roll [E09.6mm)
Media Type: Canon Heavyweight Coated Paper
Frint Pricrity: Froof
Print Quality: High [B00dpi)
Automatic Cutting: es
Label Print: e

Calor Measurement S ettings
Dirying Settings: Standard
Hlurnination: D50
Obzerver Angle: 2

All Information. .

S5

Click the OK button.
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Saving Execution Logs on the Computer

Saving Execution Logs on the Computer

You can save Acquire Color Measurement Data execution logs on the computer.

of

@ This step can be executed when a printer that has a spectrophotometer unit installed is selected.

1  Select the execution log to save on the computer in Execution Logs in the main window (Color Measurement

sheet).
7' imagePROGRAF Color Calibration Management Console - iPFooot 1o6.00¢.00.00¢ 1000 == EERE<=
File Tools Help
Printer [ Calbraion H Color Msasursment ] o
Canon PR
Il [EEoEET | ColorMease H(,' Color Check ]
Execulion Logs
Meria Tune Eapar width faty fart Tine Mane
24-in Roll (B0, Completed : 000117
= CaronHeavwe.. 24-n Rol[B03..  Completed 2012/04/1411:42 000110
Stalus Monilor ‘ 1 —
Sevebsan) [Lofavien] [ Lebasisn)

2 Select Output Execution Log CSV > Selected Logs from the Tools menu.

Q

@ To save all of the execution logs, select All Logs.
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Saving Execution Logs on the Computer

Enter the file name and save.

¥ Save As

=
{ u |@ b Libraries » Documents »

Organize ~

W Favorites
Bl Desktop
& Downloads

| Recent Places

-l Libraries
@ Documents

J’ Music

[ Pictures
E Videos

1% Computer

£ Local Disk (C)

cj Metwork

File name:

- | 3 | ‘ Search Documents

Save as type: | CSV(*.csv)

MNew folder = -
B Documents ||brary Arrange by:  Folder =
Includes: 2 locations
Name Date modified Type Size
E | PosterArtist 3/13/201210:57 PM  File folder
- 4 1 (2
e
)
Save ] [ Cancel ]

“ Hide Folders
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Switching Display Units

Switching Display Units
The units displayed in the Color Calibration Management Console can be switched between millimeters and inches.

1 Select Preferences from the File menu.

2 Select the display units in the Units sheet in the Preferences dialog box and then click the OK button.

i "y

Preferences @

Units | Sound I Color Measurement Env.

’ Defaults

oK || Cancel || ooh
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Getting Audio Notification of Color Calibration Finished

Getting Audio Notification of Color Calibration Finished

You can be notified by sound when color calibration finishes.
1 Select Preferences from the File menu.

2 Select the Color Calibration check box in the Sound sheet in the Preferences dialog box and then click the

Browse button and select the audio file.

i

Preferences @
Units | Sound | Color Measurement Env.

[ Color Check:

iPF_Completed wav Erowse . Tes
[ Color Calibration:

iPF_Completed wav Erowse Tes
[] Acquire Color Measurement Data:

iPF_Completed wav Browse .. Tes

[ Defaults
oK || Cancel || oph

Q

@ If you want to check the sound in the selected audio file, click the Test button.

3 Click the OK button.
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